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Introduzione

Il presente rapporto interno, descrive il software che ¢ stato progettato e scritto per il controllo e
I’acquisizione dei dati dei sensori lineari, sviluppati dal GAIO2 Metrologia, per il controllo dello
specchio primario dell’SRT. I sistema di misura dei sensori lineari, nasce in seguito alla necessita
di misurare le deformazioni dello specchio primario di un radiotelescopio con superficie attiva. La
possibilita infatti di modificare la posizione dei pannelli, in quanto montati su attuatori lineari,
permette di posizionare la superficie per avere sempre la forma migliore anche quando su di essa
agiscono le deformazioni gravitazionali o i gradienti termici. Queste misure e correzioni Sono
particolarmente importanti ad alta frequenza, come ad esempio a 100 GHz a cui corrisponde una
lughezza d’onda di 3 mm e quindi € necessario che la misura della superficie abbia una accuratezza
di circa cento micron. Una volta che il riflettore primario sia stato allineato staticamente in modo
“assoluto” ¢ sufficiente operare una misura “relativa” delle deformazioni rispetto a questo “punto di
zero” per mantenere la superficie nella sua forma ottimale in maniera dinamica. I sensori lineari
vengono utilizzati per la misura delle deformazioni di un riflettore di grandi dimensioni (maggiore
di 30 metri in diametro) a livelli di accuratezza di qualche centinaio di um e con una frequenza di
lettura di qualche Hz. I sensori utilizzano un CMOS lineare (modello S10077 della Hamamatsu),
formato 1024 pixels delle dimensioni di 14 pm x 50 um, per una lunghezza totale di 14.3 mm. |
pixels hanno una profondita di 10 bit (1024 livello di grigio). La scheda di controllo viene
alimentata da una tensione di 13Volts ed ha on board una FPGA, in grado di eseguire 1'impostazione
e la lettura del sensore. La scheda contiene inoltre un controllo di potenza per un diodo laser ed un
sensore di temperatura. Una immagine di un elemento del sistema €' mostrata in figura 1, si noti che
il diodo laser viene accoppiato ad ogni scatola del sensore. In figura 2 e' mostrata la scheda

elettronica in cui si notano la FPGA e il sensore CMOS.



Figura 2: La scheda di controllo (FPGA) ed il sensore
CMOS.

La comunicazione tra il sensore (slave) ed il computer host (master) avviene tramite RS485. I
sensori vengono collegati in cascata, tramite una linea cablata composta dalla linea RS485 e
dall'alimentazione (tramite un cavo a 6 poli, contenente la linea di comunicazione RS485 e
l'alimentazione). Ogni sensore viene univocamente identificato da un numero che va da 1 a 255,
possono essere indirizzati al massimo 255 sensori. L'i-esima scheda sensore, ha due connettori, uno
per il cavo proveniente dal sensore i-1, uno per il cavo che va al sensore i+l assieme
all'alimentazione del diodo laser. L'ultimo sensore di una linea ha una resistenza di terminazione a
120 Ohm. La parte finale di ogni linea giunge ad un HUB, e da li vengono fatti i collegamenti al PC
di controllo, tramite un convertitore USB-RS485.
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Figura 3: Schema di connessione.



ra 4.: Un sistema
lineari.
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Figura 5: Un HUB utilizzato per il
collegamento dei senssori lineari al PC
master.



L'applicazione LinearSensorTest
L'applicazione LinearSensorTest, ¢ scritta in C#NET. Essa utilizza la libreria LinearSensorLib per

la comunicazione con 1 sensori lineari .

Il Bussiness Object Model
L'applicazione ¢ composta da un form principale detto MainForm e da un form di opzioni detto

FormOptions.
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Figura 6. Diagramma di classe dell'applicazione LinearSensorTest.



La Human-Machine Interface
L'HMI dell'applicazione ¢ composta da un menu principale, da una listview per mostrare l'elenco

dei sensori rilevati e di un pannello dei comandi da inviare al sensore selezionato nella listview.

File Sensore Tools Help

TROVATI 1 SENSORI

Baricentro Temperatura Posizione Relativa Misura Trigger Integration
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Figura 7: La GUI dell'applicazione LinearSensorTest.

Di seguito la descrizione di alcune funzionalita fornite dall'interfaccia.

Ricerca Sensori

Dal menu File->Ricerca Sensori ¢ possibile avviare la ricerca dei sensori collegati al PC master. La
libreria LinearSensorLib, istanziando l'oggetto Reader, avvia un giro di ACKNOLEDGE, alla
ricerca di 24 sensori per ogni porta COM. Ossia per ciascuna porta COM viene eseguito un ciclo su
ida 1 a 24 per ricercare i sensori inviando un messaggio di ACK, in attesa di ricevere un messaggio

di BACKACKNOLEDGE, se il sensore 1 risulta presente.

La Lista Sensori

Al centro dell'interfaccia grafica ¢ presente quindi una listView con l'elenco di tutti i sensori trovati.



Difatti dopo aver istanziato il Reader, ¢ possibile recuperare, tramite la funzione
Reader.GetSensorList(), I'elenco dei sensori trovati. Con questo elenco ¢ quindi possibile inserire un
listViewltem per ogni sensore trovato e creare quindi la lista dei sensori, dove ogni elemento della
lista ¢ associato univocamente al sensore lineare presente nel sistema. In questo elenco ¢ possibile

leggere le seguenti informazioni:
* Sensore: il numero del Sensore.
* Baricentro: il valore del baricentro in pixels.
* Temperatura: il valore dell'ultima temperatura rilevata.

* Posizione Relativa: la differenza, in pixels, tra il baricentro rilevato e quello scelto come

zero alla pressione sul pulsante SET ZERO.

* Misura: il valore precedente espresso in millimetri, ossia il valore precedente moltiplicato

per 0,014.
» Trigger: il trigger, ossia il livello di soglia impostato.

* Integration: il tempo di integrazione impostato.

| comandi

Selezionando un sensore presente nella lista sensori appare un pannello con i pulsanti che
consentono l'invio dei comandi al sensore selezionato. Possiamo notare il comando di
SETOFFSETTRIGGER, il comando di SETINTEGRATION, il comando di LASERON, e tutti i
comandi utili per richiedere al sensore fino a 128 acquisizioni in sequenza (ACQUISITION) e le

relative immagini (GETAQUISITION) e baricentri (GETBARACQUISITION).

I comandi in broadcast, come il LASERON ed il passaggio alla velocita di 115200 baud per tutti 1
sensori, possono essere inviati accedendo dal menu Sensore->All Laser ON e Sensore->Passa a
115200 rispettivamente. E' possibile settare il baricentro di zero per tutti i sensori selezionando

Sensore->Set Zero.

Il grafico
In basso sotto il pannello comandi ¢ presente un grafico nel quale ¢ possibile vedere l'iesima
immagine o baricentro acquisite dal sensore. Viene anche mostrato il trigger o soglia otteniti

dall'immagine.



Lettura continua

Dopo aver selezionato un sensore, dal menu Sensore->Lettura Continua ¢ possibile avviare la
lettura in continuo dei sensori. Affianco a ciascuna sensore ¢ presente una checkbox, che se
selezionata, attiva la lettura continua su quel sensore. La lettura continua avviene in un thread
separato, che utilizza le funzioni Sensore.Leggilmmagine() e Sensore.LeggiBaricentro(). In alto a
destra, sopra la lista sensori ¢ possibile vedere il tempo di round trip, ossia il tempo impiagato dal
thread a leggere le immagini o i baricentri dei sensori selezionati. Il thread di lettura continua,
quando avviato, crea un file di log denominato yyyyMMdd-hhmmsstmp.log. Dove yyyy ¢ l'anno,
MM ¢ il mese, dd ¢ il giorno, hh ¢ I'ora, mm sono i minuti, ss i secondi dell'orologio di sistema.
All'interno di questo file, in formato csv, son memorizzati, nell'ordine, i seguenti dati: data\ora di
sistema, numero sensore, il baricentro scelto come zero in pixels, il baricentro rilevato in pixels, la

temperatura rilevata.

Il Menu Opzioni

Dal menu TOOLS->Options ¢ possibile accedere ad un form di opzioni. In questo form ¢ possibile
scegliere se, durante la lettura continua, richiedere al sensore tutta I'immagine o solo il baricentro.E'
inoltre possibile settare l'intervallo di lettura continua, ossia il tempo di aggiornamento della GUI
per la visualizzazione dei dati. Si noti che, invece, il thread di lettura continua viene eseguito alla

sua massima velocita, che dipende dal tipo di dati richiesti al sensore.

F T k|

o-! FormOptions =HACIH[ X

) Richiedi solo il Baricentro

@ Richiedi anche I'mmagine

Irtervallo di lettura continua: h00 '

QK ] [ Cancel

Figura 8: La finestra di dialogo delle Opzioni.



Salvataggio dati
Dal menu File->Save ¢ possibile salvare in un file di testo, separato da ';', nell'ordine, le seguenti
informazioni: baricentro calcolato, temperatura, trigger calcolato, valore dei pixels da 1 a 1024.

Queste informazioni vengono ripetute tante volte quante sono state le acquisizioni richieste.

Dal menu File->Save Image ¢ invece possibile salvare in formato bmp, il grafico dell'ultima

immagine rilevata.

Figura 9: L'applicazione utilizzata per il monitoraggio di una trave metallica.



La libreria LinearSensorLib

La libreria LinearSensorLib, ¢ scritta in C#NET. Essa contiene la logica di comunicazione tra il
computer master ed i sensori slave. La libreria implementa in un'architettura ad oggetti tutti quei
comandi che sono stati esposti nel capitolo precedente e che consentono l'interazione con i sensori

lineari.

Il Business Object Model

La libreria ¢ composta da tre classi: la classe Reader, la classe PortaCOM e la classe Sensore.



Header

A
Fublic Class
—p Object
= Properties
" ListaSenzori : List<Sensare>»
= Methods -Sensnre o
% checksum : byte Public Class
# ClosedllPorts © woid . Object
» DeserializeSensors ; void
#» GetSensorList : Sensore(] = Properties
#» GetSenzorLiztd,  List<Senszore> E?‘l.-’-\cqniElaric:entro : List< double>
@ Init : woid P AcaniBaricentroCale : List<doubles
: E::gﬁirs.t Bj:idde' EI_’ Acgnilmmagine : List<uint[]>
- SendLASEFEDN < eid E‘AcqniTemperatula : Lizt<float>
# SendvSER : wvoid E‘AcqniTrigger : Lisgt<double>
# SerializeSenzors : woid 37[' AcaniTriggerCale @ List<doubles
= Fields o BarZero : double
@ _listaSenzon : List<Senzare:> i Integration : ink
@ porteSeriali ; List<PortaCOb > 17[' Laserdn - boal
; :
ET[I MHumernSenzaore © bute
37[' OffzetTrigger : int
ET[' Temperatura : float
= Methods
# BarDiff : double
PortaCOM — # CalcolaB aricentro : »wvoid
i Tal #» checksum : byte
Public Class & GietBaud - int
Object :
=i ® GelTMP : flast
= Methods ® GetTMPUszer : float
& Hdtor - # LeggiBaricentro : woid

» checkzum : byte

®» Close ; woid

#» GetSensorList : Sensore(]

# GetSensorListd : List<Sensores
% |rit : bool

@ FortaCOM : PortaCOM

# SendlLASEROM : woid

#» SendVSER : wvoid

= Fields

@ Max_SEMSORS : int
@ portaSeriale : SenalPort
@ Sengoarn ; List<Sensore>

# Leggilmmagine : woid

#* parsedcquisitionF esponse | void

# parzeB ardcquizitionR esponze © void
®» SendACKMOLEDGE : bool

* SendACQUISITION @ bool

# SendBARACQUISITION : bool

® SendGETACQUISITION : bocl

* SendlLASERON : bool

* SendRMT : bool

* Senzore : Sensore

* Senzore : Sensore

» SetNTEGRATION : boal

# SetOFFSETTRIGGER : bool

= Fields

@ _acqniBaricentro : List<double>
acqniBaricentroCalz : List<double>
acanilmmagine : List<uint[]>

o
- :acqniTemperatula : List<float>

L]

@ _acqgniTrigger : List<double:
acqniTriggerCale : List<doubles
@ _barZero : double

@ _integration : int

@ _lasern : bool
numeradcquizizioni © int
nurneroSensore : byte

@ _offsetTrigger : int

@ _portaConn - SerialPart

@ _temperatura : float

@ R_w_ INTERWAL : int

@ TENTATIWI_INTERWAL : int

L]

L]
*

Figura 10: Diagramma delle classi della libreria LinearSensorLib.

La classe Reader possiede una lista di oggetti di tipo PortaCOM. Ogni oggetto PortaCOM
rappresenta una delle porte COM installate nel sistema ed attraverso le quali ¢ possibile comunicare
con 1 sensori collegati al computer. La classe PortaCOM possiede una lista di oggetti di tipo
Sensore, ossia la lista dei sensori collegati fisicamente a quella porta COM. La classe Sensore,
possiede quasi tutta la logica di comunicazione con il sensore cui fa riferimento. Difatti ogni istanza

di tale classe ¢ un oggetto che rappresenta fisicamente il singolo sensore collegato al sistema.



pkg Root |
Reader
(from LinearSensor::linearSensorlLib)
'l porteSeriali:List<T1 ->PortaCOM>=new List=PortaCOM={)}
#porteSerialif0] #portgSeriali[1]
PortaCOMA1 PortaCOM2 Sensore6
@1 SensoriList<T1-=Sensc @1 Sensorilist<T1-=
#Sensori[3]
#senseri0] #Sensori[1] #3ensori2]
Sensore? Sensored Sensoreb
#Sensori[l] #Sensori1] #Sen=ori[2]
Sensoret Sensored Sensore’
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Figura 11: Una possibile configurazione, quando il sistema é composto da 7 sensori collegati a
2 norte COM.



La classe Reader

La classe Reader ¢ il contenitore che possiede la lista delle porte COM installate nel sistema,
attraverso cui accede ai sensori ad esse collegati. Il costruttore, attraverso il metodo Init(), consente
l'inizializzazione della rete di sensori. Tramite il metodo GetSensorList() e GetSensorListA() ¢
possibile ottenere la lista di tutti i sensori collegati alla rete. La lista privata porteSeriali contiene

l'elenco delle porte seriali cui € collegato almeno un sensore lineare.

(from linearSensorLib)

'| porteSeriali List<T1 -=PortaCOM==new List=PortaCOM={}
'| _listaSensori List<T1-=Senzore==new List=Sensore=(}

C# Properiies

<» «Getbccessor, Setdcocessor, property» ListaSensori( ) List<T1 -=Sensore=

Methods=s
<P wconstructors Readen)
E® Init{in baud:int):woid
<% GetSensorList():Sensore®]
<» GetSensorLista()List<T1-=Sensore=
£<» SendLASERON(IN on:bool) void
% SendWSER(): woid
Er) checksumiin array:byte[*], in num:int): byte
< CloseaAllPorts() void
<» SerializeSensors(in path:string):void

<M DeserializeSensors(in path:string):wvoid
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Figura 12: Rappresentazione della classe Reader e dei suoi metodi.

Di seguito le funzionalita dei metodi pubblici.

Reader.GetSensorList()

Restituisce in un array di Sensori[] la lista dei sensori installati nel sistema.

Reader.GetSensorListA()

Restituisce in un List<T> di oggetti Sensori (List<Sensore>) la lista dei sensori installati nel

sistema.

Reader.Init(int baudRate)

Il metodo privato Reader.Init() viene richiamato dal costruttore per ricercare tutte le porte seriali



installate nel sistema, per ognuna di queste porte rilevate viene istanziato 1'oggetto PortaCOM, di
cui viene a sua volta richiamato il metodo PortaCOM.Init(). Tale metodo restituisce true se rileva
almeno un sensore lineare collegato alla porta. Se cid avviene questa istanza di PortaCOM viene
aggiunta alla lista delle porteSeriali. Puo capitare difatti che ad una porta COM di sistema non sia
collegato alcun sensore lineare oppure vi sia collegato un altro apparato, in questo caso questa porta

COM viene scartata e non viene aggiunta alla lista delle porteSeriali.

Reader.SendLASERON(bool on)

Manda in broadcast, attraverso tutte le porte della lista porteSeriali, il comando di accensione

(on==true) o di spegnimento (on==false) dei laser di TUTTI i sensori del sistema.

Reader.SendVSER()
Manda in broadcast, attraverso tutte le porte della lista porteSeriali, il comando di passaggio alla

velocita di 115200bps a TUTTTI i sensori del sistema.

Reader.CloseAllPorts()

Questa funzione chiude tutte le porte aperte col metodo Reader.Init() ed elimina i corrispondenti

handle.

Reader.Serialize Sensors()

Serializza in formato XML la lista dei sensori installati nel sistema.

Reader.Deserialize Sensors()

Deserializza in formato XML la lista dei sensori installati nel sistema.

La classe PortaCOM

La classe PortaCOM ¢ il contenitore che possiede il riferimento ad una porta COM di sistema.
Questa classe possiede la lista dei sensori lineari collegati fisicamente a quella data porta COM di
sistema. Il metodo Init() consente 1'inizializzazione della rete di sensori collegati. Tramite il metodo
GetSensorList() ¢ possibile ottenere la lista di tutti i sensori collegati alla porta COM. La lista

privata Sensori contiene I'elenco dei sensori lineari collegati fisicamente a quella porta.



PortaCOmM

[N «const: MAX_SENSORS:int=24
] SensoriList<T1-=5Sensore>=new List=Sensore=(}

] portaSeriale: SerialPort=new SerialPort()

% wconstructors PortaCOM(in comPort:=tring, in baud:int)
<» Init(}:-bool

<% GetSensorlist( ) Sensore[¥]

< GetSensorListal)List<T1-=Sensore=

Elq} wdestructors ~PortaCOM{}

D"',':- SendLASERCON(In on:bool): woid

[-_Ll"} SendWSER():woid

IEI} checksumiin array:byte[*], in num:int}:byte

¢ Close()void
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Figura 13: Rappresentazione della classe PortaCOM e dei suoi metodi.

Di seguito le funzionalita dei metodi.

PortaCOM.GetSensorList()

Restituisce in un array di Sensori[] la lista dei sensori collegati a questa porta COM.

PortaCOM.Init(int baudRate)

Il metodo privato PortaCOM.Init() viene richiamato dal costruttore della classe Reader per ricercare
tutti 1 sensori collegati a quella porta COM. Viene effettuato un ciclodaconichevadal a

MAX SENSORS, ad ogni ciclo viene istanziato un sensore con ID pari a i e poi viene inviato un
comando di ACK a quel sensore i-esimo in quella data porta. Se il sensore i-esimo esiste e risponde
con un messaggio di BACKACKNOLEDGE allora 1'oggetto sensore viene aggiunto alla lista
Sensori di questa porta. Tale metodo restituisce true se rileva almeno un sensore lineare collegato

alla porta.

PortaCOM.SendLASERON(bool on)

Manda in broadcast, attraverso quella porta, il comando di accensione (on==true) o di spegnimento
(on==false) dei laser di TUTTTI i sensori del sistema. Ossia invia il messaggio LASERON nella
porta COM, senza specificare alcun ID di sensore (ID=0).



PortaCOM.SendVSER|)

Manda in broadcast, attraverso quella porta, il comando di passaggio alla velocita di 115200bps a

TUTTI i sensori del sistema.

PortaCOM.Close()

Questa funzione chiude la porta COM di riferimento.

La classe Sensore

Questa classe rappresenta il sensore lineare connesso al sistema. Ogni istanza di questa classe
identifica un reale sensore con un dato ID. Difatti la property NumeroSensore identifica un sensore
fisico con quello specifico ID, unico in tutta la rete. Ci sara quindi una sola istanza di un sensore
con un dato valore per NumeroSensore. Questa classe incapsula, sotto forma di metodi, tutti 1
comandi che possono essere inviati al sensore lineare secondo le specifiche descritte al precedente

capitolo. Possiede inoltre un riferimento interno alla porta COM cui ¢ collegato.



La classe sensore memorizza i dati provenienti dal sensore in array di max 128 elementi (numero

massimo di
memorizza |
L'array Acq
SENDACQI
possibili ba
AcqniBarice

messaggio E

_portaCom:SerialPort

wconsts A_W_INTERWAL:int=10

gconsts TENTATWI_INTERWAL :int=10

_numeroAscquisizionizint

_barZero:double=0

_acgniBaricentro List=T1 -=double>=new List=double=(new double[128]}
_acgniTrigger:Lizt<T1-=double==new List=double={new double]123]}
_acqgniBaricentroCalc:Ligt<T1 ->double==new List<=double=(new double[122]}
_acgnilTriggerCalc:List<T1-=double==new List<double={new double[128]}
_temperatura: float=new float()

_acgniTemperatura :Ligt=T1->float==new List=float=(new float[123]}
_acqgnilmmagine :List<T1 -=uint[==new List<uint]=}

_numeroSensore byte

_integration:int

_offsefTrigger:int

_laserOn:bool

C#¥ Properiies
«Getscocessor, Setbccessor, attributes, property» BarZero( ). double
wGetdcocessor, attributes, propertys AcgniBaricentro().List<T1-=double=
xGetscoessor attributes, propertys AcgniTriggen):List<T1-=double=
wGetscocessor, attributes, property» AcgniBaricentroCale(): List<T1 -=double>
wGetscoessor attributes, propertys AcgniTriggerCalce(): List<T1-=double=
wGetscocessor, attributes, property» Temperatura (}: float
wGetdcocessor, attributes, propertys AcgniTemperatural):List<T1-=float=
wGets coessor attributes, propertys Acgnilmmagine(): List<T1-=uint[}=
wGetscocessor, Setbccessor, property» NumeroSensore( ) byte
«wGetscoessor, SetAccessor, property» Integration():int
«Getscocessor, Setbccessor, propertys OffsefTriggen):int

wGetbcocessor, Setbccessor, propertys» LaserOn(). bool

PVOCOOODOOVDOOCOOOOO (000000000000

Methods
gconstructors Sensore(in portaCom:SerialPort, in numeroSensore:byte)
wconstructors Sensore()
SendACKNOLEDGE():bool
SetiINTEGRATION(In integration:int): bool
SetOFFSETTRIGGER(In offsetint) bool
Leggilmmagine(in num:bwyte ) void
SendACQUISITIONC N num: byte):bool
SendGETACQUISTION(in num:byte) bool
parsefoguisitionResponse(in response: bytel*], in num:int):woid
CalcolaBaricentrofin immagine:uint[*], out Baricentro:double, out Trigger uint}) void
LeggiBaricentrolin num:byte) void
SendBARACQUISITIONCIN num: byte): bool
parseBarfcguisitionResponselin response: byte[*], in num:int}) woid
SendlLASERON(In on:bool): bool
SendRMT(}: bool
GetTMPUsen}): float
GefTHMP): float
BarDiff{in num:int, in calc:bool):double
checksum(in array:byte[®], in num:int): byte
GetBaud():int
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Figura 14: Rappresentazione della classe Sensore e dei suoi metodi.
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Sensore.SendACKNOLEDGE():bool
Invia al sensore il comando di ACKNOLEDGE, se quel sensore restituisce BACKACNOLEDGE,

la funzione restituisce true, restituisce false altrimenti.

Sensore.SetINTEGRATION(int integration):bool
Invia al sensore il comando di SETINTEGRATION, per definire il tempo di integrzione. Se quel

sensore risponde con un BACKACKNOLEDGE, la funzione restituisce true, restituisce false

altrimenti.

Sensore.SetOFFSETTRIGGER(int offset).:bool
Invia al sensore il comando di SETOFFSETTRIGGER, specificando il valore di offset. Se quel

sensore risponde con un BACKACKNOLEDGE, la funzione restituisce true, restituisce false

altrimenti.

Sensore.SendLASERON(bool on):bool

Invia al sensore il comando di LASERON, specificando se accendere (on = true) o spegnere (on =
false) il laser. Se quel sensore risponde con un BACKACKNOLEDGE, la funzione restituisce true,

restituisce false altrimenti.

Sensore.SendRMT():bool
Invia al sensore il comando di RMT. Se quel sensore risponde con un BACKACKNOLEDGE, la

funzione restituisce true, restituisce false altrimenti.

Sensore.GetTMP():bool

Invia al sensore il comando di TMP, restituisce la temperatura restituita dal messaggio BACKTMP.
Se quel sensore risponde con un BACKTMP, la funzione restituisce true, restituisce false altrimenti.
La temperatura restituita dal messaggio BACKTMP, viene anche memorizzata nella property

Temperatura.

Sensore.SendACQUISITION(byte num):bool
Invia al sensore il comando di ACQUISITION specificando il numero di acquisizioni che il sensore
deve effettuare. Se quel sensore risponde con un BACKACKNOLEDGE, la funzione restituisce

true, restituisce false altrimenti.

Sensore.SendGETACQUISITION(byte num):bool

Invia al sensore il comando di GETACQUISITION specificando il numero dell'immagine che si

vuole richiedere al sensore. Se la GETACQUISITION ¢ coerente, quel sensore risponde con un



SENDACQUISITION contenente 1'immagine rilevata dal sensore e la temperatura, la funzione
quindi restituisce true, restituisce false altrimenti. La funzione, richiama il metodo privato
parseAcquisitionResponse(), 1l quale memorizza le immagini restituite nella property
Acqgnilmmagine e la temperatura nella property AcqniTemperatura, nell'indice corrispondente a
num. La funzione, dopo aver richiamato la funzione Sensore.CalcolaBaricentro(), memorizza il
baricentro ed il trigger calcolati dall'immagine nelle property AcqniBaricentroCalc e

AcqniTriggerCalc rispettivamente, in corrispondenza dell'indice num.

Sensore.parseAcquisitionResponse(byte[] response, byte num)

Effettua il parsing del messaggio SENDACQUISITION. I1 messaggio SENDACQUISITION ¢ un
array di 2053 bytes contenente la temperatura in una word e le 1024 word dei valori dei pixel che
compongono 1'immagine. Dopo aver effettuato il parsing memorizza 1' immagine nella property
Acqgnilmmagine e la temperatura nella property AcqniTemperatura, in corrispondenza dell'indice

num.

Sensore.CalcolaBaricentro(byte[] immagine, out double baricentro, out double Trigger)

Calcola il baricentro ed il trigger di un'immagine. Il trigger T ¢ la media dei valori dei pixels

costituenti I'immagine. Il baricentro ¢ dato dalla formula:

ZiXi

Zii solo per le x talichex >T edoveivadala1024.
i i

Sensore.SendBARACQUISITION(byte num):bool

Invia al sensore il comando di BARACQUISITION specificando il numero del baricentro che si
vuole richiedere al sensore. Se la BARACQUISITION ¢ coerente, quel sensore risponde con un
SENDBARACQUISITION contenente il baricentro ed il trigger rilevati dal sensore, la funzione
quindi restituisce true, restituisce false altrimenti. La funzione, richiama il metodo privato
parseBarAcquisitionResponse(), il quale memorizza 1 baricentri ed 1 trigger restituiti nella property

AcqniBaricentro e la temperatura nella property AcqniTrigger, nell'indice corrispondente a num.

Sensore.parseBarAcquisitionResponse(byte[] response, byte num)

Effettua il parsing del messaggio SENDBARACQUISITION. II messaggio SENDACQUISITION
¢ un array di 12 bytes contenente il numeratore ed il denominatore del baricentro, nonché il valore
di trigger utilizzato. Dopo aver effettuato il parsing memorizza il baricentro nella property

AcqniBaricentro ed il trigger nella property AcqniTrigger, in corrispondenza dell'indice num.



Sensore.Leggilmmagine(byte num)
Questa funzione effettua la chiamata in sequenza delle funzioni Sensore.Send ACQUISITION(byte
num) e Sensore.SendGETACQUISITION(byte num). Tra la chiamata di una funzione e 1'altra viene

inserito un delay di 20 millisec. Questa funzione ¢ utile se richiamata in un thread.

Sensore.LeggiBaricentro(byte num)
Questa funzione effettua la chiamata in sequenza delle funzioni Sensore.Send ACQUISITION(byte
num) e Sensore.SendGETBARACQUISITION(byte num). Tra la chiamata di una funzione e 1'altra

viene inserito un delay di 20 millisec. Questa funzione ¢ utile se richiamata in un thread.

Persistenza

Lo stato delle impostazioni dei sensori installati nel sistema, come offset e tempo di integrazione,
possono essere memorizzati in un file tramite la funzione Reader.SerializeSensors(string path).
Possono essrere recuperati tramite la funzione Reader.DeserializeSensors(string path). Di seguito un
esempio di file xml:

<?xml version="1.0" encoding="us-ascii"?>

<Sensore xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"

xmlns:xsd="http://www.w3.0rg/2001/XMLSchema">

<Sensore xsi:nil="true" />
<Sensore xsi:nil="true" />
<Sensore xsi:nil="true" />
<Sensore>
<NumeroSensore>3</NumeroSensore>
<Integration>13000</Integration>
<OffsetTrigger>0</OffsetTrigger>
<LaserOn>false</LaserOn>
</Sensore>

<Sensore xsi:nil="true" />
<Sensore xsi:nil="true" />
<Sensore xsi:nil="true" />
<Sensore xsi:nil="true" />
<Sensore xsi:nil="true" />
<Sensore xsi:nil="true" />
<Sensore>
<NumeroSensore>10</NumeroSensore>
<Integration>0</Integration>

<OffsetTrigger>0</OffsetTrigger>


http://www.w3.org/2001/XMLSchema

<LaserOn>false</LaserOn>

</Sensore>

<Sensore

<Sensore

<Sensore

<Sensore

<Sensore

<Sensore

<Sensore

<Sensore

<Sensore

<Sensore

<Sensore

<Sensore

<Sensore

<Sensore

xsi:nil="true"

xsi:nil="true"

xsi:nil="true"

xsi:nil="true"

xsi:nil="true"

xsi:nil="true"

xsi:nil="true"

xsi:nil="true"

xsi:nil="true"

xsi:nil="true"

xsi:nil="true"

xsi:nil="true"

xsi:nil="true"

xsi:nil="true"

</Sensore>

/>

/>

/>

/>

/>

/>

/>

/>

/>

/>

/>

/>

/>

/>



LISTA COMANDI versione 2.1D

1. Comando di ACKNOLEDGE (Master -> Slave):

ACK |ADR | XXX | XXX | CHK

ACK = 0x01

ADR = Indirizzo da 1 a 255

XXX = Non Usati

CHK = CheckSum

Richiede al dispositivo, il cui indirizzo ¢ indicato da ADR, di rispondere con un comando di

BACKACKNOLEDGE (BCK).

2. Comando di BACKACKNOLEDGE (Slave -> Master):

BCK | ADR | CHK

BCK = 0x02

ADR = Indirizzo da 1 a 255

CHK = CheckSum

Comando di risposta di un dispositivo slave, il cui indirizzo ¢ indicato da ADR, a una richiesta di

ACK.

3. Comando di SETINTEGRATION (Master -> Slave):

STI| ADR | INT[O] | INT[1] | CHK

STI = 0x10

ADR = Indirizzo da 0 a 255

INT[0] = Parte bassa della Word di dati

INT[ 1] = Parte alta della Word di dati

CHK = CheckSum

Comando che impone al dispositivo, il cui indirizzo ¢ indicato in ADR, di impostare il tempo di
integrazione in funzione del valore della Word (INT[1]:INT[0]) che va da 0 a 13200 (con 0
massimo periodo di integrazione). All’accensione il valore di default ¢ 12900. Da notare che INT[0]
¢ LSB mentre INT[1] ¢ MSB. Il dispositivo slave rispondera con un comando
BACKACKNOLEDGE. Se I’indirizzo ¢ 0 il comando ¢ riferito a tutti i dispositivi della linea

(Broadcast), in questo caso perd il dispositivo non da alcuna risposta.

4. Comando LASERON (Master -> Slave):
LAS | ADR | PWR | XXX | CHK
LAS = 0x30



ADR = Indirizzo da 0 a 255

PWR = Accensione Laser

XXX = Non Usati

CHK = CheckSum

Comando che impone accensione o spegnimento del Laser al sensore il cui indirizzo ¢ indicato in
ADR. Se PWR ¢ 0 il Laser viene spento altrimenti qualsiasi valore non 0 fa accendere il Laser. Il
dispositivo slave rispondera con un comando BACKACKNOLEDGE. Se I’indirizzo ¢ 0 il comando
¢ riferito a tutti 1 dispositivi della linea (Broadcast), in questo caso pero il dispositivo non da alcuna

risposta.

5. Comando TMP (Master -> Slave):

TMP | ADR | XXX | XXX | CHK

TMP = 0x82

ADR = Indirizzo da 1 a 255

XXX = Non Usati

CHK = CheckSum

Comando che chiede alla scheda di indirizzo ADR il valore della temperatura. Tale valore viene

restituito col comando BACKTMP.

6. Comando di BACKTMP (Slave -> Master):

BTP | ADR | TMP[0] | TMP[1] | CHK

BTP = 0xC2

ADR = Indirizzo da 1 a 255

TMP[0] = Sono gli 8bit LSB di temperatura

TMP[1] = Sono i restanti 3bit MSB di temperatura

CHK = CheckSum

Comando di risposta di un dispositivo slave, il cui indirizzo ¢ indicato da ADR, a una richiesta di
lettura della temperatura. La temperatura ¢ data tramite 12bit piu un bit di segno (totale 13bit). Il

dato ¢ in complemento a due. La risoluzione ¢ pari a 0.0625°C. L’intervallo di temperatura va da

+150°C a -55°C.

7. Comando RMT (Master -> Slave):
RMT | ADR | XXX | XXX | CHK

RMT = 0x86

ADR = Indirizzo da 1 a 255

XXX =Non Usati



CHK = CheckSum
Comando che ordina al dispositivo ADR di fare un test della SRam. Se il test ha successo viene dato

un BCK. Altrimenti non vi € risposta.

8. Comando di ACQUISITION (Master -> Slave):

ACQ | ADR | NUM | XXX | CHK

ACQ =0x90

ADR = Indirizzo da 0 a 255

NUM = Numero acquisizione da fare da 1 a 128

XXX = Non Usati

CHK = CheckSum

Comando che impone al dispositivo, il cui indirizzo ¢ indicato in ADR, di eseguire una serie di
misure pari al numero indicato da NUM. Se NUM non rientra nell’intervallo da 1 a 128 il comando
non viene eseguito. Se I'indirizzo ¢ 0 il comando ¢ riferito a tutti i dispositivi della linea
(Broadcast). Il Master, dopo un certo tempo, deve inviare un comando di GETACQUISITION o di
BARACQUISITION per farsi spedire le misure dal singolo slave.

9. Comando di GETACQUISITION (Master -> Slave):

GAQ | ADR | DAT | XXX | CHK

GAQ =0x91

ADR = Indirizzo da 1 a 255

DAT = Selezione dati

XXX = Non Usati

CHK = CheckSum

Comando che impone al dispositivo, il cui indirizzo ¢ indicato in ADR, di spedire 1’ultima serie di
misure eseguite tramite il comando SENDACQUISITION (SAQ). Se il campo DAT contiene il
valore 0 lo slave inviera tutte le misure effettuate. Qualora invece il campo DAT specifichi un
valore compreso tra 1 e 128 il dispositivo inviera solo la misura indicata da DAT. Se la richiesta non
¢ consistente (esempio non sono state fatte misure o DAT supera il valore 128) viene restituito un

BCK.

10. Comando SENDACQUISITION (Slave -> Master):
SAQ | ADR | TMP[0] TMP[1] | PIX[0]...PIX[1023] | CHK

SAQ = 0x99

ADR = Indirizzo da 1 a 255

TMP[O0...1] = Temperatura del Sensore



PIX[n][0...1023] = Pixel del Sensore della n-esima Misura (Rappresenta una Word)

CHK = CheckSum

Comando (Pacchetto) che il sensore, il cui indirizzo ¢ indicato in ADR, invia al master per
comunicare i dati della misura. Questo pacchetto viene inviato in risposta al comando GAQ. Il dato
si compone di 2 Byte in complemento a 2 che indicano la temperatura e poi la misura da 1024 Word
(ogni Word 2 Byte) provenienti dal sensore lineare. Tale pacchetto puo essere ripetuto in numero da
1 a 128 a seconda di quella che ¢ stata la richiesta di misura effettuata col comando ACQ. Notare
che ogni blocco PIX contiene 1024 Pixel e ogni pixel ¢ rappresentato da una Word ove il primo
Byte rappresenta gli 8 bit MSB mentre il secondo i restanti 2 bit LSB.

Il Singolo pixel essendo a 10bit viene rappresentato con 2 bytes. In Particolare il generico dato di
pixel ¢ dato da PIX[i] = BYTE HJi] : BYTE L[i]. Dove in BYTE H[i] sono contenuti i bit da B9
... B2 e in BYTE L[i] sono contenuti i bit da B1 ... BO. Il Valore di ampiezza del generico pixel
PIX[i] viene quindi ottenuto con la seguente operazione 4 * BYTE HJ[i] + BYTE L[i].

11. Comando di BARACQUISITION (Master -> Slave):

BAQ | ADR | DAT | XXX | CHK

BAQ =0x93

ADR = Indirizzo da 1 a 255

DAT = Selezione dati

XXX = Non Usati

CHK = CheckSum

Comando che impone al dispositivo, il cui indirizzo ¢ indicato in ADR, di spedire I'ultima serie di
misure Baricentro eseguite tramite il comando SENDBARACQUISITION (ZAQ). Se il campo
DAT contiene il valore 0 lo slave inviera tutte le misure effettuate. Qualora invece il campo DAT
specifichi un valore compreso tra 1 e 128 il dispositivo inviera solo la misura indicata da DAT. Se la
richiesta non ¢ consistente (esempio non sono state fatte misure o DAT supera il valore 128) viene

restituito un BCK

12. Comando SENDBARACQUISITION (Slave -> Master):
ZAQ | ADR | TRIG[0] TRIG[1] | BARNUM]JO]...[3] | BARDEN]O0]...[2] | CHK
SAQ = 0x9A

ADR = Indirizzo da 1 a 255

TRIGJO...1] = Livello trigger usato per calcolo Baricentro

BARNUM [0...3] = Numeratore Baricentro

BARDEN [0...2] = Denominatore Baricentro

CHK = CheckSum



Comando (Pacchetto) che il sensore, il cui indirizzo ¢ indicato in ADR, invia al master per
comunicare 1 dati della misura. Questo pacchetto viene inviato in risposta al comando BAQ. Il dato
si compone di 2 Byte (Lsb:Msb) denominati TRIGJ[O0...1] che contengono il livello di trigger usato
per il calcolo del baricentro. Tutti i punti del frame aventi ordinata maggiore di tale livello
partecipano al calcolo del baricentro. Si noti che il livello di Trigger = Offset + Media.

L’Offset ¢ un valore impostabile dall’utente tramite il comando SETOFFSETTRIGGER (OFT)
mentre la media ¢ il malore medio di ordinata calcolato su tutto il frame. La seconda serie di 4 bytes
(Lsb:Msb) denominati BARNUM [0...3] rappresentano il numero intero che compone il
numeratore del baricentro. Similmente i successivi 3 bytes (Lsb:Msb) denominati BARNUM [0...2]
rappresentano il denominatore intero che compone il denominatore del baricentro. Alla fine il valore

del Baricentro (ascissa) si ottiene eseguendo il rapporto: BARNUM/BARDEN.

13. Comando di SETOFFSETTRIGGER (Master -> Slave):

OFT | ADR | OFF[0] OFF[1] | CHK

OFT = 0x94

ADR = Indirizzo da 1 a 255

OFF[0...1] = Livello offset

CHK = CheckSum

Comando che impone al dispositivo, il cui indirizzo ¢ indicato in ADR, di impostare il livello di
offset del trigger in funzione del valore della Word (OFF[1]:OFF[0]) che va da 0 a 1023.
All’accensione il valore di default ¢ 0. Da notare che OFF[0] ¢ LSB mentre OFF[1] ¢ MSB. Il
dispositivo slave rispondera con un comando BACKACKNOLEDGE.

Se I’indirizzo ¢ 0 il comando ¢ riferito a tutti i dispositivi della linea (Broadcast), in questo caso
pero il dispositivo non da alcuna risposta.

Si ricorda che per il calcolo del baricentro vengono presi tutti i pixel aventi ordinata maggiore del
Trigger. Il Trigget ¢ dato dalla somma del valore di Offset con il valore della media di ordinata di

tutti 1 pixel.

14. Comando di VSER (Master -> Slave):

VSR | ADR | XXX | XXX | CHK

ACQ =0x92

ADR =0

XXX = Non Usati

CHK = CheckSum

Il Comando ¢ solo in Broadcast e impone a tutti 1 dispositivi di passare da una comunicazione

seriale iniziale di default di 57600bps a una comunicazione di 115200bps.



La comunicazione Seriale:

La velocita di trasmissione dati ¢ impostata all’accensione a 57600bps (salvo commutare in seguito
a 115200bps). Il singolo dato (parola) del pacchetto si compone di un bit di start, 8 bit di dati e un
bit di stop. I pacchetti dal Master al Sensore sono di lunghezza fissa pari a 5 parole.

La durata di un pacchetto quindi si aggira attorno ai 0.868msS (a 57600bps). Il sensore ha un timeout
di lunghezza pacchetto pari a 3.39mS.

Se si desidera far andare il sistema a 115200bps si consigli sempre e comunque di effettuare alla
velocita iniziale di 57600bps un giro di ACK in modo da sincronizzare tutti i dispositivi della catena
di misura. E solo in seguito commutare a 115200bps. Anche in questo caso per sicurezza ¢ bene

rifare un giro di ACK.

Un tipico Esempio:

Una tipica sequenza di comandi ¢ la seguente:

ACK: Per verificare che il dispositivo risponda con un BCK

LAS: Comando di accensione del Laser

STI: Impostazione del Tempo di Integrazione

OFT: Impostazione dell’Offset che contribuisce a determinare il livello di Trigger
ACQ: Comando di acquisizione Frames

GAQ o BAQ: Lettura dei Frames (Per intero o solo il Baricentro
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